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Tonight’s Agenda 

 

FTM Questions? 

Intro to FTM 2014 

New Features 

Starting a New Tree or Import an Existing Tree 

Help Menu & Other Helpful Tips 

Ancestry.com Public Trees 

Next Class 

What Can I Do with Family Tree Maker? 

Powerful information management, easy-to-use research tools, and creative output options make Family 

Tree Maker the most complete resource for building your family tree and family history.  

 Build your family tree by entering family information you already know. 

 Search the web for new information about your family members. 

 Create and personalize your research with beautiful charts and reports. 

 Share your findings with others through charts, reports, and book publishing. 

Intro to FTM 2014 

 

Family Tree Maker (FTM) has the most dynamic features in the industry such as accessing Internet 

databases, robust and easy to use data entry, adding detailed source information, easy to use tracking 

journal, accessing millions of maps, and the ability to publish your own family history book.  

 

With the current Windows 7 or 8 or past Vista or xp platforms designed for the latest features revolving 

around the Internet and other technologies, Family Tree Maker has adopted many features. We’ll discuss 

most of these features during the next nine months. Many of these features are included in earlier FTM 

versions (2008 through 2012). Earlier FTM family files can be opened in later FTM versions. 

 

There has been several new software upgrades for FTM 2014. The latest version is 22.0.0.345 which can 

be downloaded for free after registering your software. Without registering, no updates will be given. 

 

There are seven workspace tabs located at the top of the screen to gain access to the different FTM 

features. These tabs allow users access to (Plan) building or importing a family tree, (People) add or 

modify ancestor vital information, (Places) show detailed maps of over three million locations worldwide 

using Microsoft virtual maps, (Media) add photographs, video, audio clips for each ancestor, (Sources) 

include detailed citations for each ancestor using an easy to use wizard screen, (Publish) create a locally 

or commercially printed book or genealogy report, and (Web Search) using the Internet resources with 

different online databases. 

 

References to numbered bracket boxes, ie, [1], in each paragraph are shown in each figure located above 

or below the numbered paragraphs. 
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New Features 

 

There are several new features for 2014 with major improvements. FTM 2014 has over 20 enhancements 

this year.  

 

TreeSync™has been improved with better synchronization between your home computer and Ancestry’s 

family trees online, and allows users to upload or download family tree updates to Ancestry and vice-

versa, even when using iPhone or iPad devices with the correct app (application software). The trees can 

be made public or private when uploading. New charts and reports give more ancestor information. The 

Index of Individuals report provides more info also if needed. See last page for more info on 

Ancestry.com’s Public Trees. 

 

Users can export a single family branch with less steps too. The new blended family view allows children 

from other marriages to be combined if warranted. Merging information from Ancestry.com is now easier 

too, which will be discussed in April. 

 

FTM 2014 made several improvements to their charts. And finally, the classic view is for users wanting 

the former simplified Version 16 software screen displays. Basically, it eliminates the side panels, but you 

can do the same manually. 

 

Starting A New Tree or Import an Existing Tree 

 

After installing your new 2014 software, users can import their older FTM trees from previous FTM 

versions or several other vendor genealogy software as shown in figure one below. 

 

 
Figure 1. Plan Workspace Page 

1 

2 
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The Plan workspace page has [1] three options to start your tree building process. Users can select one of 

three buttons under the ‘Getting Started’ header. If you’re new to genealogy and have some existing 

genealogy info gathered from various sources, select ‘Enter What You Know’ button, after the ‘New 

Tree’ tab is highlighted at the top. 

 

Tip: It’s recommended that users contact relatives first to see if they have done any genealogy. It’s 

possible that another relative may have completed a genealogy tree in your family. So why reinvent the 

wheel? Contact your relatives to see if anyone has completed any genealogy of your ancestors. Also it 

may be better to purchase the same software to transfer all the family file info and photos to you.  

 

[1] You can import a tree provided from a previous FTM version 5 or later or family file provided by a 

relative, or even download a known tree from Ancestry.com. 

 

Users can import an existing family file from other genealogy software including Legacy Family Tree, 

The Master Genealogist (discontinued in 2014), or Personal Ancestral File (discontinued in 2012) 

software from a relative or use the GEDCOM format, FTM will import all features from that software. 

Select the Browse button to import a file from your computer’s hard drive or external CD or DVD disk 

drive, or USB flash drive. Name the imported family file, then watch your new tree appear.  

 

The new tree family file will appear in the left panel labeled as ‘Open an Existing Tree.’ If you have more 

than one tree, you can select which tree to work with. However, users should only work with one tree 

instead of keeping many trees for the same ancestors, which can be confusing. Always date your tree files 

so you know to work with the latest file. 

 

Tip: Be careful when considering downloading a tree from Ancestry. Users need to verify the validity of 

the genealogy info as many trees have errors given by other genealogists. 

 

After the new tree is created, users can select the ‘Current Tree’ tab at the top when returning to FTM to 

see the last tree update or add more ancestors. If you use multiple trees, make sure you are updating the 

correct tree as new additions in the wrong tree take longer to correct. It’s really better to have one tree, 

unless you break the trees into different family lines. 

 

File Menu 

 

The File menu allows backup of your family file to the computer hard drive or CDs/DVDs and also 

import or export directly with other genealogy programs such as FTM (Version 5 or later), GEDCOM, 

Legacy Family Tree, The Master Genealogist, and Personal Ancestral File (PAF). More info is on the 

next page. 

 

Most of the File menu items are very similar to the previous FTM versions. Users can import a file as a 

new tree, merge a new file with an existing family file, but be forewarned to review the new file before 

merging it to make sure the information is reliable and valid, export specific individuals or the entire file 

in either the FTM or GECOM formats as shown in figure two below. Users can export files onto CDs,  

DVDs, or USB flash drives to send to relatives or even email the family file if the file size is less than 10 

MBS, due to the limitation of email attachments with most Internet email providers. 
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Figure 2. Exporting Family Files 

 

Users can send [1] specific individuals or the entire family file with or without [2] privatizing living 

people, facts, notes, photos, and reports or books. The file format output can be Family Tree Maker 

(current or past versions) or several GECOM formats. If your relative uses a different family tree program 

other than Family Tree Maker, Legacy Family Tree, The Master Genealogist, or Personal Ancestral File 

(PAF), it’s recommended to send the family file using the GEDCOM Version 5.5 (Genealogy Data 

Communications) industry standard format. 

  

Note: When sending GEDCOM files to relatives, photos and some other information won’t be included. 

GEDCOM sends only the names, dates, locations, and sources in their format. 

 

Most family tree software uses GEDCOM format for importing family files. However, several family tree 

software vendors such as Family Tree Maker, Legacy Family Tree, The Master Genealogist, and Personal 

Ancestral File can import FTM family files directly without converting to GEDCOM format. Direct 

import allows all pictures and images to be transferred to the new family tree software.  

 

Backing up family files are done automatically every time users exit the FTM program, providing users 

have setup the backup feature properly upon installing. Users can change the backup settings at any time 

as shown in figure three below. [1] Users can backup the main file on the computer’s main hard drive. 

 

 
Figure 3. Backing Up FTM Files 

 

2 

1 

2 

1 

3 
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Users can also backup the family file to [2] another drive (CD, DVD, portable hard drive or flash drive 

(aka thumb or memory stick) using the removable media besides the computer’s main hard drive as 

shown in figure three above. Users will notice the file name extensions have changed to four letters (ftmb 

for backup file) to coincide with the new Windows 7 or 8 or Vista system formats. Use [3] Custom 

Directories if you have another internal hard drive for backup. 

 

[2] The removable media applies to CDs, DVDs, or USB flash drive. It is recommended to save any 

family file(s) to a CD, DVD, or flash memory stick depending on how often you add new information 

into your family file. 

 

The family files reside inside My Documents in Windows xp or Documents in Windows Vista or 

Library Documents in Windows 7 or 8 systems. There will be two folders in Windows: one folder for 

the actual family file information and the second folder for all the media items such as family photos and 

documents. 

 

Tip: Always make a backup of your personal family files and send one to a close relative for safe keeping 

every year! Unexpected events such as fire, flood, and tornadoes in this area can destroy computers and 

family files. Don’t be a victim and backup your files often! 

 

Users can retrieve family files using the Restore command in case the main family file is damaged. Users 

can also Privatize all living persons of the family file, so they can’t be seen and not allow any 

modifications to the main file by others. 

 

Using Offline/Online does exactly as mentioned with the Internet connection at your discretion. It’s 

handy to use to keep the Internet from slowing your normal family tree activities. Don’t forget to turn the 

Internet on to use the Web Search feature, which requires the Internet for searching Ancestry or other 

online databases. 

 

Help Menu & Other Helpful Tips 

 

Users can access the Help menu by the contents, index, search box, or by the glossary. The index shows a 

list of possible subjects to learn about the software features. Users can also access the Online Help  

Center to access the Family Tree Maker website. Included with your software is a software overview 

tutorial on the different features of Family Tree Maker. 

 

Please refer to the 2014 Companion Guide 342 page book by Tana Pedersen, either available in PDF with 

the software or as a book on Ancestry.com or Amazon.com.  

 

Besides the free tutorial available in Family Tree Maker, free webinars are available on specific tips and 

trick from the FTM support staff besides providing older version support. 

 

If you have specific problems with different operating systems using PC or Mac computers, check the 

Knowledge Base on their website for answers. They can provide many helpful solutions. 

 

Don’t forget to Register your software to obtain critical updates for FREE and Activating Ancestry 

allows access to Ancesty.com’s online databases for several weeks or more. Checking Updates allow 

users to see if updates are available. 

 



Family Tree Maker January 2015 Class Handout 

 

6 

If you need more help on software issues, contact technical support at 1-800-958-9022 on M-F from 10 

am to 10 pm ET or Saturday and Sunday from 10 am to 6 pm EST. You can also email support at 

support@ancestry.com. 

 

About Family Tree Maker in the Help menu allows users to check which software version is installed. 

New updates are arriving during the year. The latest FTM version is 22.0.0345. 

 

Ancestry Public Trees 

 

This software will work with Ancestry’com’s Pubic Tree using the TreeSync™ feature. Some 

genealogists prefer not to use this feature as they may not want to reveal their entire tree to the public or 

may not use FTM genealogy software, but still can create the Ancestry Public Trees separately. It’s your 

choice, but it’s nice to use the Tree Sync™ feature if you’re trying to update both trees on Ancestry and 

your FTM software at the same time. 

 

Society Handouts & Purchases 
 

FTM 2014 handouts will be available within one week on our society website (www.lcgsco.org) under the 

Family Tree Maker webpage. Older handouts from FTM 2005 to 2007 are still available on our website. 

 

Users can purchase new FTM 2014 software from Ancestry.com, Amazon.com, Best Buy, Costco, Office 

Depot, WalMart, or Sam’s Club. There are three retail types: Essentials, Deluxe and Platinum, which give 

you 1, 3, or 6 months of Ancestry’s U.S. subscription. Platinum also gives you photo editing software too. 

 

Next Class 

 

The next class will be on February 2 at the Harmony Library in Fort Collins. We will discuss more of the 

seven main tabs and focus on building or adding to a family tree plus your questions. 

 

http://www.lcgsco.org/

